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1. Opening the EPC
Use either of the methods shown in this chapter to open the Electronic Parts
Catalogue (EPC).

Using the Desktop Icon
1. Double-click on the EPC icon from the Windows Desktop.

2. A “splash” screen appears briefly, followed by the Main Application Window.
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Using the Start Menu
1. Click on Start to open the Start menu.

2. Select Programs to open the Programs menu.

3. Select EPCPlus from the Programs menu to open a submenu.

4. Select EPC from the submenu.

5. A “splash” screen appears briefly, followed by the Main Application Window.
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2. The Main Application Window

Overview
The Main Application Window displays parts and illustrations for the open catalogue.

Menu Bar Displays pull-down menus whose commands perform EPC functions

Toolbar Displays buttons that perform EPC functions

Blocks List Lists the illustrations (blocks) for a catalogue

Image Window Displays thumbnails and full-sized illustrations

Parts List Displays the parts for an illustration

Quote List Displays parts for sale, order, etc.

Status Bar Displays the manufacturer and product line as you make selections.
Also displays a button for each window that is minimized.

Note: When you work in the Blocks List, Image window, Parts List, or Quote List,
make sure the window is selected by clicking on the window (the window’s title bar
should be highlighted). You may need to use the window’s scroll bars to view all
entries.
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Using the Blocks List
The Blocks List displays the blocks (illustrations) for the open catalogue.

To select a block from the Blocks List, highlight an entry by clicking on it or using the
arrow keys. The Parts List displays the parts from the illustration corresponding to the
selected block.
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Using the Image Window
The Image window displays thumbnail views of illustrations (as shown in this
example) or full-sized illustrations for the open catalogue.

To select a thumbnail from the Image window, click on the thumbnail to highlight it. A
thumbnail is highlighted when a thick border surrounds it. In the example above, the
top right thumbnail is highlighted.

When you select a thumbnail, the Parts List displays the parts from that illustration
and the corresponding entry in the Blocks List is highlighted.

Select Display Illustration from the Illustration menu, click on , or press F2 to
display the full-sized illustration.
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Using the Parts List

Viewing the List
The Parts List displays the parts for the currently selected block (illustration).

The "Ref No" column displays reference numbers that refer to the parts on the
corresponding illustration in the Image window.

Note: You can drag the border to the left to expand the width of the list. The
expanded list shows each part number with its name and description.
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Viewing the Parts List Icons
The following list provides an overview of the Parts List icons and their meanings.

Icon Meaning

Package, assembly, or kit

Part in a package, assembly, or kit

Part

Dealer note with part

Dealer note with package, assembly, or kit

Dealer note with part in package, assembly, or kit

Dealer note with block

Bulletin note with part

Bulletin note with package, assembly, or kit

    Bulletin note with part in package, assembly, or kit

Bulletin and dealer note with part

Bulletin and dealer note with package, assembly, or kit

Bulletin and dealer note with part in package, assembly, or kit

Bulletin and dealer note with block

Part linked with another block that contains the same part number

Package, assembly, or kit linked with another block that contains the same part
number

Bulletin and dealer note with part in package, assembly, or kit linked to another
block with the same information

Bulletin and dealer note with block linked to another block with the same
information
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Finding Additional Parts Information
Double-click on a part in the Parts List. A window showing additional information
about that part appears. If you have an inventory system connected, the window
shows the quantity in stock.

If you want to attach your own notes to a part, click on Add to open the Notes
dialogue box. You can add more than one dealer note. Your notes appear in the list,
with the most recently added note first. See “Adding Dealer Notes” for additional
information.

To delete a note, select the note and click on Delete.
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Using the Quote List
The Quote List appears in the bottom portion of the Main Application Window. It is
independent from the open catalogue, allowing you to add parts from different
catalogues to one quote.

Viewing the List
The Quote List displays parts you select for sale, order, etc. The Quote List appears
as follows. Note: The information shown here is an example only.

The Quote List includes the following information: the Parts List icon, the illustration
reference number, part number, part description, required quantity, parts on hand
(O/H), parts sold, special order parts (S/O), unit price, and total cost of listed parts.

Changing the Special Order Quantity
Use the mouse to highlight the item you want to adjust, then do one of the following:

•  Press the Right Arrow key to increase the special order (S/O) by the
required quantity.

•  Press the Left Arrow key to decrease the special order (S/O) by the required
quantity.

•  Press Shift with the arrow keys to increase or decrease quantities by single
units.

Using the Quote Popup Menu
Right-click on the Quote List to open a shortcut menu that includes all the commands
available from the Quote pull-down menu.
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3. Opening a Parts Catalogue
You can open a catalogue at any time while you are using the EPC. How you select
catalogues depends on each manufacturer’s data.

Using the Open Catalogue Dialogue Box
When you select Open Parts Catalogue from the File menu or click on , the
Open Catalogue dialogue box is displayed. The Open Catalogue dialogue box opens
in Navigate view or Find By view, depending on the manufacturer.

The Open Catalogue Dialogue Box: Initial View
When you initially select Open Parts Catalogue, the Open Catalogue dialogue box
appears in Navigate view. At this point the dialogue box is empty except for providing
choices in the “Manufacturer” drop-down list. For example:

When you click on a manufacturer, the dialogue box will either list the available
catalogues in Navigate view’s tree structure or switch to Find By view and list
available categories in a drop-down list.

Note: If only one manufacturer is available on your system, the dialogue box will
open in the view that applies to that manufacturer’s data.
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The Open Catalogue Dialogue Box: Navigate View
In Navigate view, the Open Catalogue dialogue box arranges information in a tree
structure. For example:

Click on the plus sign (+) preceding a catalogue or double-click on the catalogue
name to list the available models. The plus sign changes to a minus sign (-). In the
example above, the status line displays the navigational path to the model specified
in the opened catalogue.

OEM>>Stern Drive>>L4 (Drive)>>6T5 (NOA) 1990

To close a catalogue listing, click on the minus sign or double-click on the catalogue
name.

Note: To switch to Find By view, click on the Find button.
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The Open Catalogue Dialogue Box: Find By View
When a manufacturer has detailed model information, the dialogue box automatically
switches from Navigate view to Find By view. Or, if you are in Navigate view and
want to change to Find By view manually, click on the Find button. Either way, the
dialogue box appears as shown in this example.

In Find By view, the Find button changes to a Navigate button so you can switch to
Navigate view.

In Find By view, the EPC searches the manufacturer data and lists the available
categories in the “Category” drop-down list. Click on the list box arrow to view the
available categories. Catalogues or models that apply to the selected category are
then listed in the “Models” drop-down list. If you select All categories (as shown in
the example above), all available catalogues or models are listed.
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Setting the Catalogue Load Option
The first time you use the EPC, you must manually select a catalogue. If you want
the previously viewed catalogue to open automatically each time you start the EPC,
use the following procedure.

1. Select Options from the Tools menu to open the User Options dialogue box.

2. Click on Display to open the Display tab.

3. Click on the check box preceding Load Last Used Catalogue on Startup to
insert a checkmark ( ), as shown in the example above.

4. Click on OK.
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Opening a Catalogue in Navigate View
For some manufacturers, the Open Catalogue dialogue box opens in Navigate view.
In this view, you select catalogues and models from entries arranged in a tree
structure. Use the following procedure to open a catalogue in this view.

1. Select Open Parts Catalogue from the File menu or click on  to display the
Open Catalogue dialogue box.

2. Select a manufacturer from the “Manufacturer” drop-down box. For example:

3. When you select a manufacturer, all available catalogues for that manufacturer
are listed. For example:

4. Open a catalogue by one of the following methods.

•  Click on the plus sign (+) preceding the catalogue name.

•  Double-click on the catalogue name.

•  Highlight the catalogue name and click on OK.
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Opening a Catalogue in Find By View
When a manufacturer has detailed model information, the Open Catalogue dialogue
box automatically changes from Navigate view to Find By view.

1. Select Open Parts Catalogue from the File menu or click on  to display the
Open Catalogue dialogue box.

2. Select a manufacturer from the “Manufacturer” drop-down box. For example:

3. Select a category from the “Category” drop-down list. For example:

4. Click on Retrieve to list the catalogues (or models) in the selected category.

To narrow your search for catalogues/models in a category, type a search term in
one of the available text boxes before you click on Retrieve. For example, you
can narrow your search by frame number, engine number, model, or VIN. The
availability search fields varies by manufacturer.

5. Select a catalogue/model from the drop-down list. For example:

6. Click on OK in the Open Catalogue dialogue box to open the catalogue.
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Setting Filters Before Opening a Catalogue
Before you open a catalogue, you can filter the results by frame number, engine
number, VIN, color code, year, model, model code, production code, and country. In
most cases, entering one or more criteria can narrow a search from hundreds of
catalogues or models to a few or even a single model. Use filters individually or in
combination. You could, for example, enter a frame/engine number plus a model
year or a VIN plus a country. However, if you enter a frame/engine number plus a
VIN, the EPC will filter on the frame/engine number and ignore the VIN you entered.

Entering Frame/Engine Numbers
Depending on the manufacturer, the frame number field appears separately or in
combination with the engine number field. For example:

To filter by frame number when the fields appear as shown here, simply type a frame
number or an engine number in the appropriate field.

When the frame engine number fields appear in combination, type the number in a
two-section text box. Type the prefix code (a maximum of five characters), press the
Tab key, and type the serial number (a maximum of seven digits). For example:

Entering Color Codes
When you type a complete or partial frame number, the color codes associated with
that number are available in the "Color Code" drop-down list. For example:

Color code information appears with the code and description separated by a
semicolon (;). In this example, the code is "02X" and the description is "Black". When
you know a color, but not the code, type what you know to produce a list of matches
in the drop-down list. From the list, you can select the specific color code you need.

Entering a VIN
Type a VIN in a three-section text box. Type the three-character factory code, press
the Tab key, type the five-character prefix code, press Tab, and type the serial
number (a maximum of nine digits). You may omit leading zeros.
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4. Working with Quotes
You can create a quote to give a customer an accurate quotation for parts. This
chapter explains how to create a quote and do the following: display additional
information for a part; delete a part; add a miscellaneous part; save, open, clear, and
print quotes; use price escalation; download a quote; use order types; and work with
superseded parts.

Creating a Quote
Use any of the following methods to add a part to a Quote List.

•  Double-clicking on a part entry in the Parts List.

•  Pressing Enter on a highlighted part entry.

•  Double-clicking on an callout/hotspot in an illustration.

•  Typing a reference number from the selected illustration in the Image window.

The following example demonstrates how to select a part for a Quote List by double-
clicking on a part entry in the Parts List.

1. Open a catalogue and select a block to display the Parts List.
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2. Double-click on a part number (624-11379-00-00, for example).

If “Display Part Information Before Adding Parts to Quotes” is selected on the
User Options Display tab, a Parts Information dialogue box is displayed.

3. Click on OK.

4. If the part is included in a kit, you are prompted to specify the kit or the part.

Note: This prompt appears if “Display No Messages when adding Parts to
Quotes” is not selected in on the User Options Display tab.
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5. Make a selection based on the following guidelines.

•  Click on Yes to add the entire kit to the Quote List.

•  Click on No to add the selected part to the Quote List.

•  Click on Cancel to add neither the kit nor the part.

6. If an illustration reference has more than one part associated with it, a dialogue
box lists the associated parts.

Note: This prompt appears if “Display No Messages when adding Parts to Quotes” is
not selected in on the User Options Display tab.

7. Click on a part entry to highlight it and click on OK. The price of the part is
checked in the price book.

8. If no price book is loaded or if there is no entry for the part in the price book, an
Add Miscellaneous Part dialogue box gives you the option to add a price. The
part number, description, and quantity fields are read-only.

9. Type a price and click on OK to add the part to the Quote List with that price.
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If you click on OK without typing a price, the following prompt appears.

Clicking on Yes adds the part to the Quote List with a price of $0.00. If you click
on No, the part is not added to the list.

10. If you add a part with a price, any settings you made at the Price Escalator
dialogue box (price escalation, rounding, and/or minimum retail values) are
applied.

Displaying Additional Information for a Part
1. Double-click on a part entry in the Quote List or highlight the entry and select Part

Information from the Quote menu to open the Parts Information dialogue box.

2. When you finish viewing information, click on OK to close the dialogue box.
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Deleting Parts from a Quote
1. Click on the part you want to delete to highlight it.

2. Select Delete Part from the Quote menu to remove the part from the Quote List.

3. If you selected a part more than once, the following dialogue box will be
displayed.

4. Respond to this dialogue box in one of these ways.

•  Click on Yes to delete all occurrences of the part.

•  Click on No to delete one occurrence of the part.

•  Click on Cancel to retain the duplicate selections.

5. To delete all parts from a Quote List, select Clear Quote from the Quote menu.
The following confirmation prompt will appear.

6. Click on Yes to delete all parts from the Quote List.
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Adding a Miscellaneous Part to a Quote
This option allows you to add parts to your quote that are not in any catalogue or in a
price book. Do the following to add a miscellaneous part to a quote.

1. Select Add Miscellaneous Part from the Quote menu or press Ctrl + M to open
the Add Miscellaneous Part dialogue box.

2. Type a part number in the “Part Number” field.

The number you type is checked against a DMS or current price book. If the
number exists, all other fields are filled in automatically and made read-only.

3. If the part number is not found, do one of the following:

•  Type a part description in the “Description” field.

•  Type the part’s retail price in the “Price” field.

•  Type the quantity required for the part in the “Required Quantity” field.

4. Click on OK.
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Saving a Quote
1. Select Save Quote from the Quote menu to open the Save Quote dialogue box.

The Save Quote dialogue box shows all previously saved Quotes.

2. Type a name in the “Name” text box to save the quote under.

3. Click on OK. A message will indicate that the quote has been saved.

If you type a name that already exists, you will be asked if you wish to overwrite
that quote.

•  Click on Yes if you want to overwrite the quote.

•  Click on No to return to the Save Quote dialogue box.
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Opening a Quote
1. Select Open Quote from the Quote menu to display the Open Quote dialogue

box.

The Open Quote dialogue box shows all previously saved Quotes.

2. Highlight a saved quote and click on OK to load a previously stored quote.

If you attempt to open a quote without saving the current quote that you are
working on, a warning appears: “Current Quote Has Note Been Saved. Are You
Sure You wish To Load A Quote?”

•  Click on Yes to open a new quote without saving the current quote.

•  Click on No to return to the current Quote List without opening a new quote.

Printing a Quote
Note: You must save a quote before you can print it. If you want dealer information to
appear on the printout, enter information on the User Options dialogue box’s
Company Details tab.

1. Select Print Quote from the Quote menu, right-click in the Quote window and
select Print Quote from the popup menu, or press the F10 key.

2. The Print dialogue box will be displayed.

3. Click on OK.



Electronic Parts Catalogue User Guide  V3.0  (April 2002) 31

Using Price Escalation
1. Select Price Escalator from the Quote menu.

2. The Price Escalator dialogue box is displayed. For example:

3. For each range you specify, you can enter a multiplier to adjust the retail figures
of the parts you put in a Quote List.

The Price Escalator dialogue box features operate as follows:

Manufacturer Lists the manufacturers you can select.

Range Enter the range and multiplying factor. For example: $0 - $20
times 1.175: All parts in the price book that cost between $0
and $20 are automatically multiplied by 1.175 before being
added to a Quote List.

Range based on Select whether to base the price escalation on cost or retail
figures. The multiplication is always based on the retail price.

Escalator Rounding
options

Set up rounding of escalated values. For example: 00-.49
round up to 50.

Enable Rounding Enable rounding.

Minimum Retail Price Enter the minimum price for any line on a Quote for Parts
provided by this manufacturer. For example, if a part costs
$2.50 and the minimum retail price is set to $5.00, the Quote
window displays the price as $5.00.
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Downloading a Quote
Use the following procedure when you want to download a Quote List to request
parts via modem.

1. Select Download Part from the Quote menu to open a submenu. For example:

2. Click on a selection. Your Quote List will be transferred via your modem
connection.
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Using Order Types
The Order Types feature allows you to specify the dispatch method to use for the
current quote. You can create, edit, and delete order types. You can also select an
order type for the current quote.

1. Select Order Types from the Quote menu to open the Order Types dialogue box.

Four order types are already set up on your system by default: Airmail, Carrier,
Regular, Special. To add a new order type, click on New and enter a code letter
and a description in the appropriate text boxes.

2. Click on New.

3. Type a one-character order type and a description.

4. Click on Save to save the order type.

The order type information is saved with, and printed on, the quote.

If the order type already exists, the following message appears: “This Order Type
already exists. Please change.” If you see this message, click on OK to close the
message box, enter a different order type, and click on Save again.

If you click on Cancel before saving the new order type, the following prompt
appears: “Save Order Type Changes?”. Click on Yes to save the new order type,
click on No if you do not want to save it, or click on Cancel. If the order type
already exists, you will be prompted to change it.

5. To apply an order type to the current quote, select an order type from the list and
click on OK.

6. To delete an order type from the list, highlight the entry and click on Delete.
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Working with Superseded Parts
When a part has been superseded, the Part Supersession dialogue box is displayed.
From this dialogue box you can select the current part or one of the superseding
parts for your Quote List.

1. Click on a part entry to highlight it. The number in the right column shows the part
you selected. For example:

2. Click on OK to add the selected part to your Quote List.
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5. Working with Illustrations
The EPC provides various options for exploring illustrations. This chapter explains
how to use thumbnails, zoom in and out, move and scale, select callouts, and use
the looking glass.

Switching Between Thumbnails and Illustrations
Thumbnail view displays miniature images of the illustrations in a catalogue.

Select Display Thumbnails from the Illustration menu, click on , or double-click
on a full-sized illustration to switch to thumbnail view.

Select Display Illustration from the Illustration menu, click on , or double-click
on a thumbnail to display the full-sized illustration.

Press F2 to toggle between thumbnails and full-sized illustrations.

Zooming In and Out

Zooming In
When you first display an illustration, it may be difficult to read because the EPC fits
the entire illustration on the screen at once. You can see more detail by zooming in
on the illustration. There are several ways to zoom in.

•  Click on .

•  Press F12.

•  Select Zoom In from the Illustration menu.

•  Use rubber-banding.
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Rubber Banding
1. Position the mouse cursor a little above and to the left of the area you want to

magnify.

2. Hold down the left mouse button and drag the mouse.

3. Position the dashed outline around the area you want to magnify.

4. Release the mouse button. This magnifies the selected portion of the illustration
to fill the window. Rubber banding is also possible in the looking glass window.

Zooming Out
After zooming in, you can see more of the illustration by zooming out.

•  Click on  on the toolbar.

•  Press F11.

•  Select Zoom Out from the Illustration menu.

•  Use the mouse wheel (if available).
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Moving and Scaling an Illustration

Moving an Illustration
When you zoom in, you cannot see all of the illustration. You can move the
illustration around as follows.

1. With the mouse pointer anywhere in the illustration, hold down the right mouse
button.

2.  Move the mouse.

3. The mouse pointer changes to  and the illustration moves with the mouse.

Note: You can also use the mouse to move the Image window’s scrollbars.

Scaling an Illustration

Click on  to scale an illustration exactly to the size of the Image window.

Selecting Callouts / Hotspots
For some catalogues, illustrations have callouts/hotspots. These appear in the Image
window as a reference number with a line connecting the number to the part. When
you move the cursor within a certain distance of the hotspot, the hotspot is
highlighted and a ToolTip, showing the part's description, is displayed next to the
cursor. If more than one part is associated with the callout, the first part in the Parts
List is displayed.

Clicking

Click on a hotspot to select the first associated part from the Parts List.

Double-Clicking

Double-click on a hotspot to select the associated part from the Parts List and place
the part in the Quote List.

Note: If no hotspot is highlighted, double-clicking on an illustration displays the
thumbnail of the illustration.
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Choosing from Multiple Associated Parts

If a callout has more than one part associated with it, a dialogue box lists all the parts
associated with the reference and prompts you to select the one you need. This
prompt appears if you have disabled the "Display No Messages when adding Parts to
Quotes" option on the User Options dialogue box's Display tab. To allow the prompt
to be displayed, do the following:

1. Select Options from the Tools menu to open the User Options dialogue box.

2. Click on Display to open the Display tab.

3. If a checkmark ( ) precedes "Display No Messages when adding Parts to
Quotes", click on the check box to remove the checkmark.

4. Click on OK. With this option de-selected, the prompt will appear when more than
one part is associated with a hotspot.

Right-Clicking

Right-click on a hotspot to select the associated part from the Parts List and display
the Part Information dialogue box.

Using the Looking Glass
The Looking Glass displays the currently selected block's thumbnail in a separate
window. It shows the area being displayed in the Image window. You can move the
highlighted area in the Looking Glass window by right-clicking and dragging the
highlighted area.

Click on  to open the Looking Glass window. Click on the button again to close
the window.

Note: You can move the Looking Glass window to a different part of the screen by
clicking and dragging on the Looking Glass title bar.
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6. Searching for Parts
In an open catalogue you can search by part number, partial part number,
description, or keywords. Also available is the Where Used feature, which allows you
to search for a part or description across all catalogues of a manufacturer.

Searching for a Part in an Open Catalogue
Select Search for Part from the Search menu, click on , or press F7 to open the
Parts Search dialogue box.

This dialogue box lists all parts in the catalogue in alphanumeric order by part
number.
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Searching by Part Number
1. In the Parts Search dialogue box, click on the Part No header to highlight the

column below.

2. Type the full or partial part number in the Find text box. The part that is the
closest match to your entry is highlighted in the list below.

3. Click on Next to highlight the next matching part. Continue clicking on Next until
you locate the part you want.

4. Click on the highlighted part to display one or more blocks and a mini-illustration
in the bottom portion of the dialogue box.

Note: If the part you want is not highlighted but is on the list, click on it with the
mouse.

5. Select the required block from the bottom part of the dialogue box.

6. Click on OK to return to the Main Application Window, which shows the selected
block and highlighted part.
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Searching by Part Description
1. In the Parts Search dialogue box, click on the Name header to highlight the

column below.

2. Type the part description in the Find text box. The part that is the closest match to
your entry is highlighted in the list below.

3. Click on Next to highlight the next matching part. Continue clicking on Next until
you locate the part you want.

4. Click on the highlighted part to display one or more blocks and a mini-illustration
in the bottom portion of the dialogue box.

Note: If the part you want is not highlighted but is on the list, click on it with the
mouse.

5. Select the required block from the bottom portion of the dialogue box.

6. Click on OK to return to the Main Application Window, which shows the selected
block and highlighted part.
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Applying Filters to Narrow Your Search
Use the following procedure to create and apply filters to narrow a search.

1. From the Parts List in the Main Application Window, click on Filter to open the
Filters dialogue box. For example:

Any filters and settings currently associated with the selected grid are displayed
in the corresponding sections of the dialogue box. The list of columns that can be
filtered on is taken from the headers. They are listed in the order they appear
from left to right in the grid column headings.

2. Click on a header in the Add Filter list. The Filter Words text box becomes active.
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3. Type the text to filter on.

In this example, Description has been selected from the Add Filter list and RING
has been typed in the Filter Words text box.
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If you type more than one word, the Options radio buttons become active. For
example:

Selecting one of these radio buttons refines the filter to match all words or to
match any of the words. For example, clicking on "Find all the words" would filter
on both "oil" and "filter". Clicking on "Find any of the words would filter on either
"oil" or "filter".
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4. Click on the Add Filter button to insert the filter in the Current Filters list.

Apply Filter to Empty
Cells

Click on this check box to insert a checkmark ( ) to hide
empty cells in the selected column. If you do not select this
option, empty cells will be displayed with the filter results.

Filter Out Words Click on this check box to insert a checkmark ( ) to filter out
the text you typed in the Filter Words text box.

Disable Filters Click on this check box to insert a checkmark ( ) to disable
current filters temporarily without deleting them. To re-enable
the filters, click on the check box to remove the checkmark.

Remove Filter Highlight the filter(s) you want to remove and click on this
button to delete one or more filters,

Remove All Click on this button to delete all filters.

Note: You can add more than one filter, including additional filters on the same
column heading.

Note: If the text in the Add Filter list or the Current Filters list extends beyond the
width of the field, position the mouse pointer over the text to display the entire
description.
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Applying Color Code Filters
When you open a catalogue for a manufacturer that has color code data available,
you can create and apply a color code filter to narrow your search.

1. From the Parts List in the Main Application Window, click on Filter to open the
Filters dialogue box.

2. Click on the Color Code header in the Add Filter list. Color Codes are displayed
in the Select Color(s) list.

3. Click on a color code in the Select Color(s) list to highlight the code.

Note: To select more than one color code at a time, hold down the Ctrl key and
click on each code you want to filter on or hold down the Shift key and click on
the first and last codes in a range of codes you want to filter on.
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4. Click on OK to insert the selected color code in the Filter Words text box.

5. Click on the Add Filter button to insert the color code filter in the Current Filters
list.
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Using the Where Used Feature
The Where Used feature allows you to search for a part number or description across
all catalogues of a manufacturer. If you want to find out what models use a particular
part, Where Used can provide this information. You can use the Where Used options
for a catalogue other than the one already open.

Selecting a Manufacturer

1. Select Where Used from the Search menu, click on , or press Shift + F7 to
open the Where Used dialogue box.

2. Click on the manufacturer drop-down box and select a manufacturer.

3. Part numbers and descriptions are listed for the selected manufacturer.
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Where Used: Applying Masks
The Masks dialogue box allows you to superimpose a manufacturer’s part number
mask into the Where Used dialogue box. This mask provides a template for the
format of the part number and reduces the number of digits you need to enter. All you
need to do is fill in the blanks.

Note: The Masks dialogue box is active when the part number column is selected.
Settings are saved when you exit if the Auto-Save option is enabled.

1. In the Where Used dialogue box, click on Masks. The Masks dialogue box will be
displayed.

2. Select a mask from the drop-down list. The following are examples of available
formats.

XXX-XXXXX-XX-XX

9XXXX-XXXXX-XX

No masks

3. Click on OK.

4. To deselect a mask, select No masks from the drop-down list.

Where Used: Searching by Part Number
1. Click on the Part Number heading to highlight that column.

2. Optional: Use the Masks feature if appropriate.

3. Type the full or partial part number in the Find text box and click on Go. The part
that is the closest match to your entry is highlighted in the list below.

4. Click on the highlighted part to display the catalogues the part occurs in and
select a catalogue. The number of available catalogues is displayed. Find is also
available for assisting your search of a catalogue.
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5. Click on the required block in the bottom left field. A thumbnail view of the
selected block appears in the lower right corner of the dialogue box.

6. Click on OK to return to the Main Application Window. The selected catalogue
opens, and the selected block and part are displayed.

Where Used: Searching by Part Description
1. Click on the Description heading.

Note: The Masks feature is not available for text searches.

2. Type the full or partial description in the Find text box and click on Go. The part
that is the closest match to your entry is highlighted in the list below.

3. Click on the highlighted part to display the catalogues the part occurs in and
select a catalogue. The number of available catalogues is displayed. Find is also
available for assisting your search of a catalogue.
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4. Click on the required block in the bottom right field. A thumbnail view of the
selected block is displayed.

5. Click on OK to return to the Main Application Window. The selected OEM opens,
and the selected block and part are displayed.
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7. Using Additional Features

Using the Find Feature
The Find feature is dynamically interactive, meaning that it begins searching as soon
as you type the first letter or number in the Find text box. You can use the Find option
as follows.

Click on a column header to select the column. The column background turns gray.

Typing in the Find text box finds the first row in the list that matches your input. This
is independent of which row is currently selected and starts from the top. This Find
routine is dynamic, which means that once typing begins, if a match is found, the
highlight moves to that row. As shown in the example above, ref.no. 2a-2 is
highlighted.

Typing C in the Find text box highlights ref.no. 2a-43. This entry is the first row that
meets the Find criteria in the description column.

Typing L to add to the Find criteria moves the highlight to ref.no. 9-50. This entry is
the first row that meets the full criteria “CL”.
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If the Find criteria do not match any items in the list, the highlight remains on the last
highlighted row. In this example, typing X caused the highlight to remain on the same
row.

If a space is the last character of the criteria, Find highlights items containing the text
string before the last space in the criteria.

Typing OIL as the Find criteria highlights row 16.

Adding a space to make the find criteria “OIL ” highlights row 5. This entry includes
the word “OIL” somewhere in the description.



54 Electronic Parts Catalogue User Guide V3.0  (April 2002)

If another letter is added to the Find criteria, Find looks for the first item matching the
entire string. Adding the letter F, for example, makes the search criteria “OIL F”.

Note: Using “OI” and “OI ” produces the same result as using “OIL” and “OIL ”.
However, using “OI F” produces no results.

Click on Next to move the highlight to the next row that meets the Find criteria.

If you reach the bottom of the list, the following prompt appears.

Find has reached the end of the list.
Do you want to start again from the top?

Respond to this prompt in one of these ways.

•  Click on Yes to move to the top of the list and highlight the first row that
matches the criteria.

•  Click on No to stop the search and remain at the last highlighted row.
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Viewing Bulletins
Use the Bulletins menu to access bulletins (where available) for blocks, parts,
catalogues, and manufacturers.

Viewing Catalogue Bulletins

Select Catalogue from the Bulletins menu or click on  to open the Catalogue
Bulletins dialogue box, from which you can view catalogue bulletins. This command
is available when a catalogue is open or when the catalogue has bulletins attached.

Viewing Block Bulletins

Select Block from the Bulletins menu or click on  to open the Block Bulletins
dialogue box, where you can view block bulletins. This command is available when a
catalogue is open or when the selected block has bulletins attached.

Viewing Part Bulletins

Select Part from the Bulletins menu or click on  to open the Part Bulletins
dialogue box, where you can view part bulletins. This command is available when a
part is selected or when the selected part has bulletins attached.

Viewing Bulletins for All Manufacturers
Select All Manufacturers from the Bulletins menu to open the Bulletins dialogue
box, where you can view all bulletins. This command is available when a catalogue is
open. Click on a header to sort the list by the selected column. Select a bulletin and
click on View to open a window displaying the bulletin.
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Using the Bulletin Buttons

Print opens the Print dialogue box, from which you can print the selected
bulletin.

Fit Illustration in Window resizes a bulletin to fit the Image window.

Zoom Out zooms out one level on a bulletin.

Zoom In zooms in one level on a bulletin.

Rotate Bulletin rotates a bulletin 90 degrees clockwise.

Previous Page displays the previous page of a bulletin.

Next Page displays the next page of a bulletin.

Help opens the Help topic for the current screen.
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Printing
You can print a Parts List, an illustration, or a quote. The print job will be sent to the
printer you selected as your Windows default.

Printing Parts Lists and/or Illustrations

1. Select Print from the File menu, click on , or press Ctrl+P to open the
Illustration and Parts Printing dialogue box.

2. Click on the radio button corresponding to what you want to print.

Note: Some options are not available in thumbnail view or illustration view. Some
options print in landscape only.

3. Click on OK.

4. In addition to the parts text and/or illustration, the printout will show the following:

•  The catalogue title

•  The product line

•  The page number
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Changing the Print Setup
1. Click on Setup to open the Print Setup dialogue box.

2. Select a printer, page size, orientation, etc., depending on the type of printer
installed.

3. Click on OK.
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Printing a Quote
Note: You must save a Quote List before printing it.

1. Use one of these methods.

•  Select Print Quote from the Quote menu.

•  Right-click in the Quote window and select Print Quote from the popup
menu.

•  Press the F10 key.

2. The Print dialogue box will be displayed. For example:

3. Click on OK.

4. In addition to the quote ("Part Estimate"), the printout will show the following:

•  The name under which the Quote List was saved

•  The order type

•  The date on which the Quote List was saved

•  The dealer code, contact name, V.A.T. registration number, and company
registration number as shown on the User Options dialogue box's Company
Details tab
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Adding and Removing Dealer Notes
You can attach your own notes to blocks and parts. These notes will remain with the
catalogue as long as you want for future reference.

These notes will be displayed automatically when you select Catalogue, Block, or
Part from the Notes menu. You can also view these notes by clicking on the note
icons when they are available.

You can attach notes to individual parts or to blocks. If someone has added a note
previously, one of the following icons will appear.

Dealer note with a block

Dealer note with a part

Dealer note with a package, assembly, or kit

You can add or read a note by double-clicking on the part or block.

Adding a Note to a Block or Parts List
1. Double-click on a part or block to open the Parts Information or Block Information

dialogue box.

2. Click on Add to open the Notes text window.

3. Type the note.

4. Click on OK. The note appears in the "Dealer Notes" section of the dialogue box.
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Removing a Note from a Block or Parts List
You can delete a note by selecting it and clicking on Delete in the Block Information
or Parts Information dialogue box.

Loading a Price Book
Select Load Price Book from the Tools menu to load a Price Book from diskettes.
You may be prompted to insert additional price book diskettes.

In Microsoft Windows networks this option is disabled in client systems because the
clients access price books from the server.

In a Novell client configuration, this option is enabled because the price book must be
installed from a client.
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8. Setting User Options

Select Options from the Tools menu or click on  to open the User Options
dialogue box from which you can use the General, Display, Images, and Company
Details tabs to do the following: set auto-save, quote, and Euro extension options;
select a language and set navigational options; adjust thumbnail and illustration
zoom settings; and type company information.

Setting General Tab Options
Click on the User Options dialogue box General tab to view the available options.
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Setting AutoSave Options
Save Settings when EPC closes: Enables auto-save for settings such as the grid
setup, column width, etc. for the open OEM.

Note: Changes to the user options are saved even is auto-save is not enabled.

Number of Last Used Catalogues to Save: Set the maximum number of
previously-opened catalogues to be listed in the recently-used catalogues list.

Number of Quotes to Save: Set the maximum number of quotes to be listed in the
recently-saved quotes list.

Enabling Euro Extensions
Enable Euro Extensions for: Enables the calculation and display of Euro
extensions for the currency you select from the drop-down list.
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Selecting a Specific Currency

1. Click on the "Enable Euro Extensions for" box to insert a checkmark.

2. Click on the drop-down list box arrow to open a list of currencies.

3. Click on the appropriate currency to highlight it. It will be displayed in the list box.

4. Click on OK.

Setting a Custom Exchange Rate

1. Click on the "Enable Euro Extensions for" box to insert a checkmark.

2. Click on the drop-down list box arrow to open a list of currencies.

3. Scroll to the bottom of the list and click on Custom. "Custom" will be displayed in
the list box and the text box to the right will be activated.

4. Type an exchange rate in the text box. For example:

5. Click on OK.

Setting Quote List Options
Put double quotes around strings containing delimiters: Inserts double quotation
marks around strings in the Quote List.

Delimiter: Select the delimiter used for data exported to an external application.

Enable Price Escalator: Enables price escalation for parts in a Quote List.

Enable Order Types: Enables order types for quotes.

Print Part Notes: Enables the printing of part notes and color information when they
are available below the part description.
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Setting Display Tab Options
Click on the User Options dialogue box Display tab to view the available options.

Language: Select a language for the application. When information is not available
in the selected language, it is displayed in English.

Display Block Information when a Block is Selected: The Block Information
dialogue box appears automatically when you select a block.

Display Part Information Before Adding Parts to Quotes: The Part Information
dialogue box appears automatically when you select a part.

Load Last Used Catalogue on Startup: The most recently used catalogue loads
automatically when you start the application.

Display Additional Help in Status Bar: An additional status bar is displayed.

Display No Messages when adding Parts to Quotes: No messages are displayed
when duplicate reference numbers and parts in kits are added to the Quote List.

Grid Lines: Select the grid line display for the Parts List and Quotes List.

Text Case: Select the character case for the Parts List and Quotes List.



66 Electronic Parts Catalogue User Guide V3.0  (April 2002)

Setting Images Tab Options
Click on the User Options dialogue box Images tab to view the available options.

Evenly Space Thumbnail Images: Evenly spaces thumbnails.

Zoom In/Zoom Out Percentage: Set the percentage for Zoom In  and Zoom Out
 between 10 and 50 percent.
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Typing Information at the Company Details Tab
Click on the User Options dialogue box Company Details tab to view the available
fields.

Type information about your company such as name, address, and important
numbers. This information appears on printed quotes.
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9. Reference

Using the Toolbar
The toolbar appears at the top of the Main Application Window just below the menu
bar. The buttons provide quick access to EPC commands.

Hiding/Displaying and Docking/Undocking Toolbar Sections
Sections of the toolbar can be undocked and placed as separate toolbars in the Main
Application Window.

File toolbar

Imaging toolbar

Information toolbar

Select Toolbar from the View menu to open a submenu from which you can hide or
display the Imaging and Information toolbars. You can also undock sections of the
toolbar by dragging them onto the main window area.
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Using the Toolbar Buttons
When you point the mouse cursor on a toolbar button, an identifying label appears.
Click on a button to activate the corresponding command.

Open Parts Catalogue displays the Open Catalogue dialogue box, from which
you can select a manufacturer and catalog or model.

Open Quote displays the Open Quote dialogue box.

Print opens the Illustration and Part Printing dialogue box.

Send Parts to Invoice sends the parts in a Quote List to a DMS.

Return to Invoice takes you back to your DMS application.

Reset Windows resets the application window to its default size and each child
window to its original size.

Search for Part opens the Parts Search dialogue box, from which you can
search for a part in the open catalogue.

Where Used opens the Where Used dialogue box, from which you can search
for a part across all catalogues of an OEM and see where it is used.

View Previous Block (Illustration) displays the previous illustration in a
catalogue.

View Next Block (Illustration) displays the next illustration in a catalogue.

Display Thumbnails displays thumbnails of illustrations.

Display Illustration displays full-sized illustrations.

Display Looking Glass opens the Looking Glass window, which allows you to
magnify portions of an illustration.

Fit Illustration in Window resizes an illustration to the dimensions of the
image window.

Zoom Out (Make Illustration Smaller) zooms out one level on an illustration.

Zoom In (Make Illustration Larger) zooms in one level on an illustration.

Rotate Image rotates an illustration 90 degrees clockwise.

Catalogue Notes opens the Catalogue Information dialogue box.

Block Notes opens the Block Information dialogue box.
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Part Notes opens the Part Information dialogue box.

Catalogue Bulletins opens a list of bulletins for the open catalogue.

Block Bulletins opens a list of block bulletins for the open catalogue.

Part Bulletins opens a list of part bulletins for the open catalogue.

Options opens the User Options dialogue box from which you can change
general, language, display, and zoom settings and type company information.

EPC Help opens the application online Help.
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Using the Pull-Down Menus
The EPC menu bar is displayed at the top of the Main Application Window.

The menu names are always visible, but the commands available from each menu
depend on the location in the Main Application Window and the data available at that
particular stage. You can access the menu bar by clicking on the menu items with the
mouse or by using the keyboard and shortcut keys.

Certain letters are underlined. These are the shortcut letters. For example, to open
the File menu, press Alt + F. Then use the arrow keys to move through the menu or
click on one of the underlined letters in a command.

The File Menu

Open Parts Catalogue: Opens the Open Catalogue dialogue box. Select a
manufacturer and open a parts catalogue in either Navigate or Find By view.

Print: Opens the Illustration and Parts Printing dialogue box. Click on the radio
button corresponding to what you want to print. Then click on OK.

Send Parts to Invoice: If the EPC is connected to a DMS, this command sends all
parts from the Quote Window to an invoice application.

Return to Invoice: If the EPC is connected to a DMS, this command returns you to
an invoice application.

Recently Used Catalogues: The area of the menu above the Exit command lists
recently used catalogues. Click on an entry to open the corresponding catalogue.

Exit: Displays a confirmation prompt: “Closing EPC. Are you Sure?” Click on Yes to
close the application.
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The Quote Menu

Part Information: Opens the Part Information dialogue box. This command is
available when a part is selected in the Quote List.

Delete Part: Deletes the highlighted part from the Quote List. If you have selected
the part more than once, a dialogue box appears. You can delete one or all
occurrences of the part or retain the duplicate selections. This command is available
when you highlight a part in the Quote List.

Add Miscellaneous Part: Opens the Add Miscellaneous Part dialogue box. Type a
part number. If the number is in a DMS or current price book, the remaining fields are
filled automatically with read-only data. If the application cannot find the part number,
you can type a part description, price, and quantity.

Save Quote: Opens the Save Quote dialogue box. Type a name to save the quote
under.

Open Quote: Opens the Open Quote dialogue box. Highlight a saved quote and
click on OK to load a previously stored quote.

Clear Quote: Displays a confirmation prompt. Click on Yes to clear the current
quote.

Print Quote: Opens the Print dialogue box. Click on OK to print a saved quote.

Price Escalator: Opens the Price Escalator dialogue box. For each specified range,
enter a multiplier to adjust the retail figures of the parts you put in the Quote window.

Download Quote: Downloads a quote to an external application.

Order Types: Opens the Order Types dialogue box. Enter and save a one-character
order type. Select an order type from the list to apply an order to a quote.

Recently Used Quote List: Opens a previously used quote.
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The View Menu

Blocks: Restores a minimized Blocks List to its default size.

Parts: Restores a minimized Parts List to its default size.

Quotes: Restores a minimized Quotes List to its default size.

Reset Windows: Resets the application window and child windows to their default
sizes.

Toolbar: Opens a submenu with Imaging and Information commands which display
and hide the Imaging and Information toolbars.

When a sub-toolbar is selected (�), it is enabled.

Imaging Toolbar Information Toolbar
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Information: Opens a submenu with three commands.

Catalogue/Model Info Catalogue/Model Info opens the Catalogue Information
dialogue box from which you can view catalogue or model
information and add or delete dealer notes.

Block Info When a block is selected, Block Info opens the Block
Information dialogue box which displays catalogue, model,
and figure information, dealer notes, and manufacturer notes.
You can also add or delete dealer notes.

Part Info When a part is selected, Part Info opens the Part Information
dialogue box from which you can view information for the
selected part and add or delete dealer notes.
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The Illustration Menu

Note: The first command on the menu toggles between Display Thumbnails and
Display Illustration as the view in the application changes.

Display Thumbnails: Displays illustrations in thumbnail view.

Display Illustration: Displays illustrations in illustration view.

Display Looking Glass: Opens the Looking Glass window which displays the
currently selected illustration in thumbnail view. When you drag the mouse pointer in
the Looking Glass window to define an area, the corresponding portion of the
illustration is magnified. You can move the defined area around by right-clicking on
the Looking Glass window. The mouse pointer changes to a hand, allowing you to
drag the defined area. The magnified portion of the illustration changes accordingly.

Fit Illustration to Window: Resizes an illustration to the dimensions of the Image
window.

Zoom Out: Zooms out on an illustration.

Zoom In: Zooms in on an illustration.

Restore to Normal Size: Restores an illustration to its normal size.

Rotate Image: Rotates an illustration 90 degrees.

View First Block (Illustration): Displays the first illustration in a catalogue.

View Previous Block (Illustration): Displays the previous illustration in a catalogue.

View Next Block (Illustration): Displays the next illustration in a catalogue.

View Last Block (Illustration): Displays the last illustration in a catalogue.
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The Search Menu

Search for Part: Opens the Parts Search dialogue box which allows you to search
for parts by number or description. The Filters dialogue box allows you to narrow
your search. This command is available when a catalogue is open.

Where Used: Opens the Where Used dialogue box which allows you to search for a
part or description across all catalogues of a manufacturer.

The Notes Menu

Catalogue: When a catalogue is open, displays the Catalogue Information dialogue
box from which you can view catalogue information and add dealer notes.

Block: When a catalogue is open, displays the Notes Information dialogue box from
which you can view block information and add dealer notes.

Part: When a Parts List is displayed, opens the Part Information dialogue box from
which you can view parts information and add dealer notes.

The Bulletins Menu

Catalogue: Opens the Catalogue Bulletins dialogue box from which you can view
catalogue bulletins. This command is available when a catalogue is open and the
catalogue has bulletins attached.

Block: Opens the Block Bulletins dialogue box from which you can view block
bulletins. This command is available when a catalogue is open and the block has
bulletins attached.

Part: Opens the Part Bulletins dialogue box from which you can view bulletins. This
command is available when a part is selected and the part has bulletins attached.

All Manufacturers: Opens the Bulletins dialogue box from which you can view all
bulletins. This command is available when a catalogue is open.
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The Tools Menu

Options: Opens the User Options dialogue box from which you can use the General,
Display, Images, and Company Details tabs to change general settings; language
and other display settings; thumbnail and illustration zoom settings; and company
information.

The Help Menu

EPC Help: Opens the EPC Help Introduction.

Contents and Index: Opens the EPC Help Contents and Index.

About: Opens the About EPC dialogue box, which displays the EPC version;
copyright information; data release details for each OEM loaded on your system; MS
Windows information; and a button that allows you to display registry information for
the EPC. Click on the OK button to close this dialogue box.
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Using a Mouse
The procedures in this user guide refer to clicking or double-clicking. If you are
unfamiliar with using a mouse, please read the following information.

Point Move the mouse pointer to position it over an item.

Click Position the mouse pointer over an item and rapidly press and release
the left mouse button.

Double-Click Position the mouse pointer over an item and rapidly press and release
the left mouse button twice.

Right-Click Position the mouse pointer over an item and rapidly press and release
the right mouse button.

Drag Position the mouse pointer over an item, press and hold the left mouse
button, move the mouse while holding down the button, and then
release the button.
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Working with Windows

Maximizing Windows
Maximize the Blocks List, Image window, Parts List, and Quote List by using any of
these methods.

•  Double-click on the window's title bar.

•  Click on the window's  maximize button.

•  Click on the icon in the top left corner of the window and select Maximize
from the menu that opens.

Minimizing Windows
Minimize the Blocks List, Parts List, and Quote List by using any of these methods.

•  Click on the window's  minimize button.

•  Click on the window's  close button.

•  Click on the icon in the top left corner of the window and select Minimize from
the menu that opens.

Note: You cannot minimize the Image window.

Restoring Windows
Restore a maximized window to its original size by double-clicking on the window’s
title bar.

Restore a minimized window to its original size by using one of these methods.

•  Select the Blocks, Parts, or Quotes command from the View menu.

•  Click on the button on the Status bar. In this example, Blocks and Parts List
buttons are displayed, indicating that those two windows are minimized.
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Resizing Windows
You can resize windows by dragging the border between two adjacent windows.
When you point the cursor on a border, it changes to a double-headed arrow.

You can then drag the border. For example:

Resetting the Display
You can reset the display to the default settings. Select Reset Windows from the
View menu to set all windows to their default sizes.
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Working with Information Columns

Resizing Information Columns
You can resize information columns by dragging column header boundaries.

For this example, place the mouse pointer on the boundary between the Ref No and
Description column headers. The pointer changes to a double-headed arrow.

Drag the boundary to the left to expand the Description column or drag the boundary
to the right to expand the Ref No column.

Displaying and Hiding Information Columns
You can also select which columns are displayed. Right-click on a column header to
display a popup list. Then select which columns you want to display.

A checkmark ( ) preceding a column header title indicates that the column is
displayed. Clicking on the header title to remove the checkmark hides the column.

When no checkmark precedes a column header title, the column is hidden. Clicking
on the header title inserts a checkmark and displays the column.
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10. Glossary
Check Box

A box in which a click is required to select or deselect an option. A checkmark in a
box indicates that the option has been selected or enabled.

Dialogue Box

A window that opens when you select an item. A dialogue box lists options or
prompts for additional information. For example, the Add Miscellaneous Part dialogue
box prompts you to type a part number and description, a price, and a quantity.

Once you type the required information, the OK button becomes active. Clicking on
the button adds the part to your Quote List.

Drop-down Box (Drop-down List)

A box that opens a list from which you can make selections.

1. Click on the arrow located on the right side of the box.

2. A list of choices drops down.

3. Click on a selection.

4. The item you selected appears in the box.
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Field

A general term for a box or specified area on the screen for typing characters or
selecting options. Drop-down boxes and text boxes are types of fields.

Function Keys

The top row of keys, labeled F1 through F12.

Grid

From the User Options dialogue box you can define the view of a dialogue box by
means of lines (grids). You can set up no grid, horizontal lines, or vertical lines.

Group

A self-contained portion of a dialogue box. For example, the Filters dialogue box
consists of two groups: the Add Filter group and the Current Filters group.

Highlight

Do the following to highlight a group of characters.

1. Position the mouse pointer in front of the first character you want to select.

2. Press and hold down the left mouse button.

3. While holding down the button, drag the mouse to the last character in the group.

4. Release the button. The characters you selected will be highlighted. For example:
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Radio Button

A circle in which a click is required to select or deselect an option. A dot in a circle
indicates that the option has been selected or enabled.

Rubber Band

A rectangular box outlined with a dashed line that appears when you click and drag
on an illustration. It is used in the EPC for zooming in on an illustration. For example:

Tab

Some dialogue boxes have more than one page. Each page is referred to as a "tab".
In the EPC, you move from tab to tab by clicking on the tab controls at the top of the
dialogue box. For example, the User Options dialogue box consists of four tabs.

Text box

A box in which you type text or in which text is displayed. For example, the Filters
dialogue box includes a Filter Words text box in which you type text to filter on.

Window

An on-screen rectangle that contains a particular set of information. The Main
Application Window, Parts List, and Quote List are examples.

Other windows appear when you select options.
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